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1. Avvio rapido


Questa breve presentazione ti darà una panoramica di tutte le funzionalità di Peakto, senza 
andare nei dettaglio, in modo da poter iniziare rapidamente a goderti le tue foto.


Peakto è un meta-catalogatore che raccoglie in un'unica interfaccia tutte le foto di un 
fotografo, grazie alla sua compatibilità con molti software di fotoritocco (Apple Photos, 
Lightroom Classic, Luminar AI/Neo, Capture One, Aperture, iView Media), con cartelle e file 
di foto, e con gli account Instagram.


Peakto è progettato per essere la torre di controllo che restituisce il quadro generale ai 
fotografi sulle loro foto e fornisce strumenti per gestire, analizzare, ordinare 
automaticamente e creare album oltre i limiti dell'app.


1.1.Interfaccia di Peakto


1.2.Come iniziare con Peakto?

Peakto è l'hub digitale per tutte le tue immagini.


È stato progettato per diventare il luogo in cui accedi a tutti i tuoi cataloghi di foto e collezioni 
di immagini. Supporta le seguenti app di catalogazione (Apple Photos, Lightroom Classic, 
Luminar 4, Luminar AI, Luminar NEO, Aperture, Capture One, iViewMedia, Instagram e 
altre).


Peakto ti permetterà di :


2.5.4. Ricerca centralizzata grazie ai filtri	 
27

2.6.Visualizza le tue immagini su una mappa	 
28

2.7.Categorizza automaticamente le tue foto grazie all'AI	 
29

2.8.Accesso alla tua applicazione di modifica	 
30

3. Modifica degli spazi di lavoro  30

3.1.L'area di lavoro di editing Pixelmator Pro	 
30
3.1.1. Modifica di qualsiasi immagine in Pixelmator Pro	 
31

3.2.L'area di lavoro di modifica DXO PhotoLab	 
31
3.2.1. Fare riferimento alle versioni DXO al di fuori delle cartelle osservate	 33



-	 i.   Esplorare le tue foto in un'unica interfaccia

-	 ii.  Cercare tra tutte le tue foto

-	 iii. Categorizzare automaticamente le tue foto grazie all'IA

-	 iv. Annotare e gestire le tue foto

-	 v.  Modificare le tue foto e raggruppare le diverse versioni

-	 vi. Creare album da più fonti ed esportali


Per iniziare a utilizzare Peakto, collega le tue foto seguendo i consigli su come aggiungere 
fonti fotografiche nelle sezioni successive.


1.2.1. Lancio di Peakto per la prima volta

Quando avvii Peakto per la prima volta, sarai accolto da una schermata di benvenuto che 
evidenzia le funzionalità chiave del software. Puoi sempre tornare a quella schermata 
usando Help ➜  Welcome… dal menu Help.


Peakto rileverà anche quali sono le app che hai installato sul tuo Mac e proporrà di attivare 
alcune integrazioni specifiche. Puoi bypassare questo passaggio e configurare queste 
integrazioni in un secondo momento dalla finestra di dialogo Impostazioni. Se sei pronto per 
configurare queste integrazioni, segui semplicemente le istruzioni sullo schermo. Questo è 
discusso in modo più dettagliato in 1.3 Aggiungere cartelle.




1.3.Aggiungere cartelle

Basta trascinare qualsiasi cartella dal Finder nell'interfaccia utente Peakto o, in alternativa, 
scegliere File ➜ Attach Folders… dal menu File. Puoi anche usare il pulsante “+” nella parte 
inferiore dell'interfaccia per rivelare il menu relativo e scegliere “Attach Folders…”.


1.3.1. Adding folders

Simply drag any folder from the Finder to the Peakto user interface or alternatively, choose 
File ➜ Attach Folders… from the File Menu. You can also use the global “+” button at the 
bottom of the interface to reveal the Add menu and choose “Attach Folders…”.




La finestra che appare usando“+”.


1.3.2. Aggiungere cataloghi

Se conosci la posizione dei tuoi cataloghi, puoi semplicemente trascinare il file del 
catalogo nell'interfaccia utente Peakto. Funziona per:

-	 Librerie di Apple Photos

-	 Files di catalogo Lightroom .lrcat

-	 Files di catalogo Capture One Pro .cocatalog

-	 Files di sessione Capture One Pro .cosessiondb

-	 Files di catalogo Luminar

-	 Files di catalogo iView Media Pro .ivc

-	 Etc…




In alternativa puoi scegliere File ➜ Attach Catalogs… dal menu File o utilizzare il pulsante 
"+" nella parte inferiore dell'interfaccia per rivelare il menu Add e scegliere la voce “Attach 
Catalogs…”. Entrambe le azioni riveleranno il browser del catalogo che eseguirà la 
scansione di tutte le unità collegate alla ricerca di cataloghi.




Il browser del catalogo


Dal Browser del Catalogo puoi selezionare qualsiasi catalogo rilevato dall'elenco a sinistra 
e allegarlo a Peakto


1.3.3. Validating catatogs

Prima di allegare un catalogo, Peakto eseguirà alcuni test sul contenuto per rilevare possibili 
problemi come volumi di immagine mancanti, incompatibilità della versione del catalogo. 
Tutti i problemi vengono visualizzati nella finestra di Checklist. Dovresti prenderti un 
momento per leggere i problemi rilevati e decidere se va bene procedere o se dovresti 
eseguire prima alcune ottimizzazioni ai cataloghi. Peakto cerca di suggerire alcune possibili 
soluzioni. 


La finestra dei Checklist


1.3.4. Visualizzazione di tutte le fonti

Una volta acquisite, tutte le fonti appaiono nella barra laterale e sono raggruppate per tipo. 
Accanto al nome della fonte, Peakto visualizzerà alcune icone di stato (vedi sotto) che 
indicano:

-	 Se la sorgente (cartella o catalogo) è online / offline

-	 Se la sorgente (cartella o catalogo) richiede una sincronizzazione

-	 Se la sorgente (cartella o catalogo) è aperta




È possibile accedere a molti comandi dal menu contestuale della sorgente (cartella o 
catalogo)


Le fonti nella barra laterale (a sinistra). Il menu contestuale (a destra) che dà accesso a molte possibili azioni

sul file sorgente.




1.3.5. Comprendere il processo di acquisizione


Quando una fonte di immagini (cartelle o cataloghi) viene ingerita in Peakto, questo quanto 
accade :

-	 La Sorgente viene completamente letta, vengono acquisiti i metadati di tutte le 
immagini.

Ciò include i metadati nei file immagine o i metadati presenti nei sidecar (XMP,...)

-	 La struttura organizzativa della sorgente è completamente letta. Questo include la

gerarchia delle cartelle per le cartelle acquisite e la struttura completa del catalogo (album , 1

cartelle, progetti, ...) per i cataloghi.

-	 Alcune miniature sono costruite per ogni versione presente nei cataloghi o nelle 
cartelle..

-	 Gli instants (vedi dopo) sono risolti.


Una volta che le attività di acquisizione sono finite, la fonte può essere visualizzata, cercata, 
filtrata, ecc...,


Tuttavia, viene generata un altra attività di lunga durata che analizzerà tutte le immagini ed 
eseguirà alcuni rilevamenti basati su AI, al fine di costruire tutte le parole chiave, i punteggi 
utilizzati da Panorama. Questa attività di lunga durata può essere annullata e ripresa in 
qualsiasi momento in seguito..


1.3.1. Il Catalogo Peakto

Peakto costruisce il proprio catalogo con i dati acquisiti. I principi di progettazione alla 
base del catalogo Peakto sono i seguenti:

-	 Non vengono create copie delle immagini master: quando viene letto un catalogo no 
viene copiata nessuna delle immagini .

Viene minimizzata la quantità di spazio su disco utilizzato: le miniature che vengono

create sono piccole e ci si affida alla possibilità di accedere alle anteprime ad alta 
risoluzione all'interno dei cataloghi o delle cartelle sottostanti on demand.

-	 Permette di lavorare con i dati offline: è possibile indicizzare cataloghi o cartelle che 
si

trovano su unità esterne e scollegare tali unità. Peakto ti permetterà di annotare, 
organizzare, cercare,... anche se il contenuto è offline.

-	 Cerca di creare anteprime delle immagini che riflettano in modo più accurato

l'aspetto dell'immagine nel catalogo sorgente. Se si acquisisce un catalogo Luminar con 
modifiche pesanti su tutte le immagini, cerca di accedere alle anteprime che Luminar ha 
generato per visualizzare le versioni in Peakto. Quando tali anteprime non sono 
disponibili, viene indicato.


La posizione del catalogo Peakto è per impostazione predefinita la cartella Peakto 
all'interno della cartella Immagini.


Questa cartella può essere spostata in un'altra posizione e Peakto ti chiederà di indicare 
la nuova posizione al riavvio.


 Gli Smart album vengono ignorati in quanto Peakto non è in grado di ricreare le regole che sono state utilizzate nel 1

catalogo originale, a causa delle diverse capacità di quelle app



Puoi anche avere più cataloghi in più posizioni se preferisci lavorare in questo modo. 
Peakto imita il comportamento dell'app Apple Photos quando si tratta di cambiare 
catalogo:

-	 È possibile utilizzare il tasto Opzione premuto quando si avvia Peakto per 
visualizzare una

finestra di dialogo dedicata che consente di scegliere una posizione del catalogo o 
scegliere una posizione esistente


-	 Puoi accedere alla posizione corrente nella schermata delle preferenze e modificarla 
da lì.


1.4.Comprendere Instants

Molte app di fotoritocco non distruttive  possono gestire più versioni di uno scatto originale. 2

L'idea è quella di consentire all'utente di esplorare molti tipi di regolazioni sulla stessa 
immagine e creare tutte le varianti necessarie. Queste varianti sono chiamate copie virtuali 
in Lightroom o DXO PhotoLabs, varianti in Capture One Pro, ecc..


Peakto spinge quel concetto un po' oltre: infatti, poiché Peakto può gestire più fonti 
sottostanti, può accadere che la stessa immagine originale (master) sia stata modificata in 
varie app, causando l'esistenza di più versioni in diversi cataloghi. Per riunire tutte queste 
versioni sotto lo stesso tetto, Peakto usa il concetto di Instant. Instant raggrupperà tutte le 
versioni oltre i confini dell'app. Questo raggruppamento si basa sulla somiglianza delle 
immagini e su alcune considerazioni sui metadati.


Il controllo sulla costruzione degli Istants è accessibile nelle preferenze.


 Alcune app come Luminar o Apple Photos non supportano ancora questo concetto.2



1.4.1. Identificazione delle immagini con più versioni

Ogni miniatura nella vista a griglia può visualizzare il numero di versioni nell'Instant 
sottostante (vedere Anatomia di una cella a griglia). Quando viene visualizzato un numero 
significa che c'è più di una versione e puoi andare alla vista dei dettagli per visualizzare 
l'Instant.


1.4.2. Visualizzazioni degli instants

Quando si apre la vista dei dettagli per una versione che appartiene a un Instant, Peakto 
visualizzerà tutte le versioni presenti in quell'Instant a sinistra e a destra di un separatore. 
Ogni miniatura è contrassegnata con il catalogo di origine.




Possono verificarsi diverse situazioni


Se le versioni sono nella selezione corrente, vengono visualizzate a sinistra del separatore, 
come nell'esempio seguente dove tutte le versioni sono copie virtuali nello stesso catalogo 
Lightroom.




Se le versioni sono in fonti distinte da quella attuale, vengono visualizzate su ciascun lato 
del separatore, come nell'esempio qui sotto dove le versioni sono in Lightroom o in Apple 
Photos.






Se non sono disponibili versioni al di fuori della versione attualmente visualizzata, viene 
visualizzato quanto segue.







2.  Funzioni di base di Peakto


2.1.Esplorare utilizzando la griglia

La vista a griglia è probabilmente la vista più familiare disponibile in Peakto per visualizzare 
le immagini. Funziona di pari passo con la barra laterale: la selezione della barra laterale 
guida ciò che viene mostrato nella griglia. Puoi selezionare:

- una specifica sorgente

- uno specifico tipo di sorgente (ad esempio tutti i cataloghi Capture One)

- più fonti contemporaneamente, utilizzando il tasto Comando (⌘) per creare più selezioni

- tutte le fonti che utilizzano l'elemento All Sources nella parte superiore della barra laterale

- un'area di lavoro di modifica specifica (ad esempio Pixelmator Pro) per visualizzare tutte le

immagini in quell'area di lavoro 

- un album specifico






La griglia ti consente di passare dalla vista Instants a Versions:

-	 Nella vista Instant, tutte le versioni di un Instant sono compresse e una singola 
versione (chiamata poster) viene visualizzata nella Griglia.

-	 Nella visualizzazione Versions, tutte le versioni vengono visualizzate una accanto

all'altra.


2.1.1. Anatomia di una cella della griglia

 In addition to displaying an image, each cell of the grid can display additional information 
using overlays. 





Cella della griglia


Il badge Instants Information viene visualizzato quando ci sono più di 1 versione in un istant. 
Il badge assume la forma nn/mm dove nn è il numero di versione nell'ambito attualmente 
selezionato, mentre mm è il numero totale di versioni trovate da Peakto. Nell'esempio sopra, 
1/2 significa che c'è 1 versione nell'ambito corrente su un totale di 2.


Il tipo di informazioni visualizzate viene controllato utilizzando la voce View ➜ Grid View 
Options dal menu View o utilizzando il menu contestuale View Options accessibile tramite 
Control+Click nella griglia.






Menu contestuale per controllare le opzioni di visualizzazione


2.2.Classificazioni e note per le tue immagini

Mentre Peakto ti dà accesso ai metadati e alle classificazioni/note presenti nei 
cataloghi o nei file sottostanti, puoi anche aggiungere le tue classificazioni/note 
personalizzate.


Puoi anche classificare/annotare con:

·	 Bandiere,

·	 Tag Colori,

·	 Stelle

·	 Preferiti.

·	 Titolo /Sottotitolo / Copyright /…







Tali informazioni vengono visualizzate una volta selezionata una foto:

·	 in Inspector,

·	 nella vista di dettaglio, nella parte inferiore di ogni immagine,

·	 nella vista Griglia, facendo clic sull'icona modifica.






The inspector gives additional information about the origin of the annotations. A blue icon 
indicates that the annotation has been made in Peakto. Click on it to reveal the annotated 
version from the original editing app.


2.2.1. Annotazioni e sidecars XMP

Peakto può sfruttare i sidecar XMP per scambiare annotazioni con altri strumenti che 
supportano XMP (Adobe Bridge, DXO Photolab,...). Questo è attualmente limitato alle 
sorgenti che sono "Cartelle controllate". Per attivare questa opzione, apri il pannello Peakto 
Preferences e seleziona la scheda Sync.


Per attivare il roundtrip XMP per le cartelle controllate, è sufficiente selezionare "Automatico" 
per l'opzione Roundtrip XML. Quando selezionato, significa che un sidecar XMP verrà 
creato o aggiornato ogni volta che viene aggiornata la versione master corrispondente. Nel 
caso dei file JPEG, un'opzione aggiuntiva consente di controllare se le annotazioni devono 
essere scritte nei file. Questo è utile in quanto alcuni strumenti non si basano su sidecar 
XMP per i file non-RAW, ma leggono i metadati dalle immagini stesse..


L'attivazione  del  roundtrip  tramite  XMP  ti  consente  di  utilizzare  Peakto  per  aggiungere 
annotazioni ai file e vedere quelle annotazioni propagate ad altri strumenti che sfruttano i 
dati XMP.


2.2.2. Annotazioni ed esportazione


Quando si esportano versioni annotate da Peakto, i valori annotati possono essere aggiunti 
alle immagini esportate tramite un'opzione disponibile nel pannello di esportazione. Scegli 
l'opzione appropriata dal menu a discesa Write Metadata in File. Tutti i metadati e Exif e 
IPTC (senza GPS) scrivono entrambi annotazioni personalizzate sul file.







2.3.Lavorare con i filtri

I filtri sono un ottimo modo per trovare le immagini limitando l'ambito attraverso alcuni criteri. 
Peakto supporta 2 modi di filtrare nell'interfaccia utente:

-	 Tramite la barra dei filtri sotto la barra degli strumenti. Questa barra può essere

mostrata o nascosta utilizzando l'icona Filtro accanto al campo di ricerca..

-	 Tramite il pannello centrale per creare potenti filtri basati su date, parole chiave, volti

e struttura




2.3.1. La Barra dei Filtri


La barra dei filtri ti dà accesso ai filtri più comuni e ti consente di ordinare la vista in base a 
una varietà di proprietà dell’immagine.




2.3.2. Il Pannello Centrale

Il pannello centrale contiene una varietà di criteri di filtro e viene mostrato/nascosto facendo 
clic su una delle 4 categorie, che sono:




- Struttura: questo pannello contiene tutti gli elementi strutturali che vengono letti dai 
cataloghi sottostanti come raccolte, cartelle, progetti. Nel caso delle cartelle del File 
System, il pannello della struttura mostra le sottocartelle della piega superiore guardata.


- 􀉉 Date: tutte le date delle immagini, organizzate per anno/mese e giorno.

- 􀋡 Parole chiave: tutte le parole chiave del catalogo sottostante, comprese le relazioni 

gerarchiche

- 􀉩 Volti: tutti i volti del catalogo sottostante.


2.3.3. Salvare i filtri

I filtri non possono essere salvati come tali, ma è possibile creare Smart Album in base a 
una combinazione di tali filtri.


2.4.Lavorare con gli albums

Puoi raggruppare le foto in collezioni chiamate album. Se hai familiarità con app come Apple 
Photos / Lightroom / CaptureOne... allora gli album sembreranno molto naturali in Peakto.


Gli album posono essere di due tipi:

-	 Explicit albums in cui si aggiungono manualmente immagini tramite drag and drop

-	 Smart albums Che sono definiti tramite un insieme di regole e aggiornano il loro

contenuto in modo dinamico


Gli album appaiono nella parte inferiore della barra laterale e vengono creati da File ➜ New 
Album… / File ➜ New Smart Album… azioni del menu dal menu File o utilizzando il pulsante 
"+" nella parte inferiore della barra laterale.


Tutti gli album possono contenere foto da tutti i tipi di sorgenti.


2.4.1. Explicit Albums

Explicit albums, Una volta creati, vengono popolati tramite trascinamento dei contenuti.


2.4.2. Smart Albums

Gli Smart Albums vengono creati combinando criteri su un attributo di immagini che esistono 
all'interno del catalogo:

-	 EXIF metadata

-	 IPTC metadata e annotazioni/catalogazioni

-	 Parole chiave e categorie di immagini generate da Panorama

-	 Punteggi generati da AI

-	 Propietà file e percorso




Le regole possono essere arbitrariamente complesse e mescolate con  operatori logici AND 
e OR.


2.4.3. Organizzare gli album in cartelle

Gli album possono essere comodamente organizzati in gerarchie usando le cartelle.





2.4.4. Esportazione di Albums

Gli album consentono di esportare batch di immagini da più fonti. Ad esempio, puoi 
raggruppare le foto da Apple Photos, Lightroom e una cartella nello stesso album. Senza 
modificare l'archiviazione delle tue foto, Peakto può esportare tutte le tue foto, nella migliore 
risoluzione possibile.


Peakto dettaglia la risoluzione delle immagini esportate. È possibile modificare le dimensioni 
delle immagini che si desidera esportare. Puoi esportare i file originali nel formato originale o 
esportare un'anteprima contenente le tue ultime modifiche (JPEG, TIFF, PNG). Puoi 
esportare i tuoi file con i metadati inclusi (tranne quelli attribuiti in Peakto).


2.5.Cerca tra tutte le tue foto


Utilizzando l'intelligenza artificiale, Peakto rivoluziona il modo in cui gestisci e interagisci con 
le tue foto digitali. Offrendo una ricerca centralizzata che ti permette di sfogliare facilmente e 
velocemente tutte le tue foto, indipendentemente da dove sono archiviate. L'IA di Peakto 
può analizzare ogni immagine, capirne il contenuto e classificarla di conseguenza. Che tu 
abbia una foto di un tramonto, di un compleanno, o di una giornata in spiaggia, Peakto può 
identificarla e categorizzarla in modo appropriato.




Per spingere i limiti ancora più avanti, Peakto ha introdotto 3 importanti funzionalità che 
elevano l'esperienza di ricerca di foto a un livello completamente nuovo.


2.5.1. Ricerca di foto conversazionale

La ricerca di foto conversazionale è una caratteristica rivoluzionaria nell'ultima versione di 
Peakto, che trasforma il modo in cui interagisci con la tua collezione di foto. Questa 
funzionalità innovativa consente agli utenti di trovare facilmente immagini digitando comandi 
o frasi in linguaggio naturale in qualsiasi lingua.







•Passo 1: Iniziare una Ricerca Conversazionale 
Fai clic sull'icona del Dialogo di fronte alla barra di Ricerca per avviare una 
ricerca di foto conversazionale. Inizia digitando una parola chiave o una frase 

descrittiva che rappresenta l'immagine che desideri trovare. Ad esempio, puoi 
digitare "tramonto" se stai cercando foto con tema tramonto.

• Passo 2: L'Analisi Intelligente di Peakto
Peakto sfrutta avanzate capacità di elaborazione del linguaggio per interpretare e analizzare 
il tuo testo digitato. Comprende la tua richiesta di ricerca e valuta i tuoi contenuti per 
identificare immagini pertinenti che corrispondono alla tua richiesta. Il sistema comprende 
accuratamente la tua intenzione e avvia il processo di ricerca di conseguenza. Rileva anche 
il linguaggio utilizzato.



• Passo 3: Affinare la Ricerca 
La ricerca funziona meglio quando vengono utilizzate più parole per descrivere l'intento. 
Aggiungere ulteriori dettagli o specifiche aiuterà a restringere ulteriormente i risultati. Questo 
ti permette di individuare esattamente le immagini che si adattano meglio alle tue esigenze. 
Puoi regolare il numero di risultati ottenuti scegliendo una tolleranza più ampia o più stretta.


Puoi scrivere in qualsiasi lingua se sei connesso a Internet. Se sei offline, puoi cercare solo 
in inglese.


• Passo 4: Navigare i Risultati della Ricerca 
Una volta generati i risultati della ricerca, puoi navigare facilmente tra di essi per localizzare 
l'immagine specifica che stai cercando. Con un'interfaccia user-friendly, Peakto presenta i 
risultati in modo organizzato, permettendoti di sfogliare la collezione senza interruzioni. Il 
testo di ricerca che hai utilizzato viene logicamente aggiunto come criterio nel campo di 
ricerca.


• Passo 5: Aggiungere Visi e Luoghi
Fai clic sulle icone Persona e Luogo per cercare foto con una specifica persona o luogo già 
taggati nei tuoi cataloghi. Ad esempio: "@Lisa che mangia gelato a #Barcellona”.


Per saperne di più, ecco alcuni consigli per sfruttarlo al meglio.


Promemoria: come funziona?


La ricerca funziona trasformando un testo di interrogazione in un numero specifico chiamato 
firma e confrontandolo con tutte le firme pre-calcolate delle tue immagini. Quando sono 
vicine, allora l'immagine è considerata candidata per il risultato dell'interrogazione. La 
nozione di "vicino" è ambigua poiché dipende dal testo dell'interrogazione, dalla lingua e dal 
contenuto dell'immagine. È facile ordinare le immagini restituite per distanza da questa 
interrogazione e mostrare prima le più vicine...ma è difficile trovare quando smettere di 
visualizzare le immagini.

Questo spiega perché a volte non troverai immediatamente quello che stai cercando.


La tolleranza
Il pannello di ricerca ha un menu a tendina che ti permette di regolare il livello di tolleranza 
tra stretto / standard / tollerante. Questo cambia semplicemente il valore della soglia 
menzionata sopra e mostrerà un numero maggiore o minore di immagini.


Alcuni consigli:
• Usa molte parole: più precisa è la query, più preciso sarà il risultato.

• Non esitare a impostare una soglia più bassa utilizzando l'impostazione 'Tollerante', 

anche se significa che otterrai più immagini restituite.

• Fai attenzione al numero di immagini nell'indice... se questo numero è molto diverso 

dal numero di immagini nel tuo database, potrebbe essere che l'indice non sia 



completamente caricato. Considera l'idea di riavviare Peakto per vedere se quel 
numero cambia.


• Controlla la lingua rilevata: Peakto comprende molte lingue, ma convertirà la query 
in inglese per utilizzare il suo modello di IA. Assicurati che la lingua mostrata nel popup 
sia davvero la lingua che usi per digitare.


In ogni caso, inviaci un feedback se incontri problemi.


2.5.2. Ricerca di immagini basata sulla somiglianza


Peakto offre una potente funzione di Ricerca di Immagini basata sulla Somiglianza che 
consente agli utenti di trovare immagini con contenuti simili basandosi su una specifica 
immagine selezionata come base. La somiglianza viene considerata su molti livelli 
nell'immagine: soggetto principale, colori, sfondo, condizioni di luce, ecc... Peakto restituirà 
per prime le immagini identiche o quasi identiche, e successivamente le immagini simili.




• Passo 1: Seleziona un'Immagine di Base
Per iniziare, scegli una specifica immagine dalla tua collezione che servirà come base per la 
ricerca di somiglianze. Questa immagine fungerà da punto di riferimento per trovare altre 
immagini con attributi simili. Puoi selezionare solo un'immagine.


• Passo 2: Avvio della Ricerca
Una volta selezionata l'immagine di base, premi "Control+Click" per accedere alla finestra di 
dialogo, che fornisce l'opzione "Trova Immagini Simili...". Seleziona questa opzione, e 
apparirà una finestra di ricerca dedicata, che mostra le Immagini Simili trovate da Peakto.

Puoi anche accedere comodamente alle immagini simili dal nuovo pannello dei filtri dedicato 
alle caratteristiche simili.


• Passo 3: Analisi e Corrispondenze
Gli algoritmi avanzati di Peakto analizzano il contenuto della tua immagine di base scelta per 
identificare le sue caratteristiche chiave. Queste caratteristiche possono includere schemi di 
colori, oggetti o persone specifiche presenti, composizione generale o l'atmosfera della foto.


• Passo 4: Risultati della Ricerca
Peakto analizza intelligentemente la tua collezione di immagini, cercando quelle immagini 
che condividono tratti simili con la tua immagine di base. La piattaforma corrisponde le 
caratteristiche identificate e mostra tutte le immagini pertinenti. I risultati della ricerca sono 
presentati in ordine di somiglianza, con le immagini che corrispondono più da vicino che 
appaiono in cima alla lista. Per controllare il numero di risultati ottenuti, puoi regolare il livello 
di tolleranza, selezionando una gamma più ampia o più stretta di somiglianze.


2.5.3. Ricerca per caratteristiche simili:


La funzione "Ricerca per simili" in Peakto ti consente di identificare e raggruppare in modo 
efficiente immagini con caratteristiche simili dalla tua collezione. Queste caratteristiche 
possono variare da aspetti tecnici come l'impostazione ISO o il tipo di lente a attributi legati 
al contenuto, come la fotografia di paesaggio, ritratto o macro.


•Passo 1: Scegliere un'Immagine di Base
Per iniziare, devi selezionare un'immagine di base dalla tua collezione. 
Questa immagine servirà come punto di riferimento per trovare altre immagini 
con caratteristiche simili.


Nota: se selezioni più di 1 immagine, Peakto elencherà solo le caratteristiche che sono 
comuni a quelle immagini






• Passo 2: Utilizzare il Nuovo Pannello dei Filtri
Peakto dispone di un pannello dei filtri accessibile dalla barra superiore, progettato 
specificamente per la funzionalità di Ricerca per somiglianza. Clicca sull'icona per 
visualizzare il pannello. Troverai un elenco completo di varie caratteristiche associate alla 
tua immagine selezionata. Queste caratteristiche comprendono sia dettagli tecnici, come 
l'impostazione ISO e il tipo di lente, sia annotazioni (valutazioni, parole chiave....) e 
classificazioni basate sul contenuto (da Panorama per esempio).


• Passo 3: Esplorare Immagini Simili
Clicca su qualsiasi caratteristica elencata che ti interessa utilizzare per il confronto. Puoi 
selezionare una o più caratteristiche che desideri che altre immagini condividano con la tua 
immagine di base.




• Passo 4: Creare Filtri con il tuo mouse
Quando clicchi su una caratteristica, essa viene automaticamente aggiunta al campo di 
ricerca, eliminando la necessità di digitazione o regolazioni manuali. Il software gestisce 
questo processo per te, semplificando l'esperienza di ricerca.


• Passo 5: Vedere i risultati immediatamente
Man mano che i filtri vengono aggiunti, Peakto recupererà prontamente tutte le immagini che 
corrispondono alle caratteristiche selezionate, presentandoti una collezione raffinata di 
immagini pertinenti.


2.5.4. Ricerca centralizzata grazie ai filtri


Per cercare tra tutte le tue foto, usa una qualsiasi delle viste, seleziona tutte le tue fonti 
nella barra laterale sinistra, quindi usa la barra di ricerca in alto al centro e digita le tue 
query. Puoi limitare la tua ricerca a cartelle/cataloghi/album specifici selezionandoli nella 
barra laterale.

Puoi cercare utilizzando i metadati associati alle tue foto da te, dai tuoi dispositivi 
(fotocamera, smartphone), dal software che hai usato per modificare la tua immagine o 
attribuito automaticamente da Peakto.


Cerca per metadata:

● Modello di Fotocamera,

● Obiettivo della Fotocamera,

● Software,

● EXIF, 

● IPTC.







Tali informazioni appaiono nell'Ispector. È possibile visualizzare alcune di tali informazioni 
direttamente nella visualizzazione Griglia utilizzando le Opzioni visualizzazione griglia, nel 
menu Visualizza.


Puoi anche cercare in base alle tue annotazioni: ●   Bandiere,

●	 Colori,

●   Stelle,

●   Preferiti.


Tali informazioni appaiono una volta selezionata una foto: ●   in inspector,

●   inella vista di dettaglio, nella parte inferiore di ogni immagine, ●   nella vista Griglia, 
facendo clic sull'icona modifica.


Puoi anche cercare in base alle parole chiave dei cataloghi sottostanti o alle parole chiave 
generate dall'AI. Grazie al riconoscimento delle immagini, Peakto annota anche le tue foto 
automaticamente con parole chiave, in base al loro contenuto e stile. Puoi usare le parole 
chiave assegnate dall'AI per trovare immagini, ad esempio tutte le tue immagini di uccelli 
digitando "Uccello" nel campo di ricerca.





2.6.Visualizza le tue immagini su una mappa

Quando le immagini hanno informazioni GPS, puoi vederle visualizzate su una mappa. 
Sono disponibili due tipi di mappe:


-	 nell'ispector, viene inserita una minimappa sulle coordinate dell'immagine 
attualmente

selezionata, se disponibile




-	 La barra degli strumenti consente di accedere a una mappa globale in cui vengono

visualizzate tutte le immagini dell'ambito corrente


2.7.Categorizza automaticamente le tue foto grazie all'AI

Peakto AI analizza automaticamente le tue immagini e le categorizza.


Senza modificare le strutture originali dei tuoi cataloghi, Peakto ti offre una vista ordinata 
delle tue immagini nella vista panoramica. Puoi anche usare le categorie assegnate dall'AI 
come query di ricerca.


1. By category:

2. Architecture, 

3. Astro-photography 

4. Wildlife

5. Automotive

6. Events & Wedding

7. Fashion

8. Food & Drinks

9. Nature

10. People 

11. Portrait

12. Screenshots

13. Sport

14. Street

15. Water & Underwater


○ Per Stile:

■ Abstract

■ Aerial

■ Close Up

■ Night


○ Armonmia e Colori

■ Compound

■ Complementary 

■ Triad

■ Simple Split

■ Colors: Brown, Chocolate, Goldenrod, Yellowgreen, Medium 

Aquamarine…

○ Persone


■ Alone

■ In Duo

■ In a Small Group 

■ In a Large Group


○ Luce

■ Bright

■ Dark Images

■ Highly Saturated

■ UnderSaturated

■ High Contrast

■ Low Contrast




2.8.Accesso alla tua applicazione di modifica

Peakto è l'hub centrale per tutte le tue foto. Puoi fare clic con il pulsante destro del mouse su 
qualsiasi immagine per aprirla nel software di editing che hai usato per modificarla.


Puoi anche aprirlo in un altro software di editing direttamente da Peakto. Una volta 
modificata, l'anteprima della tua foto viene aggiornata in Peakto. Se hai bisogno di forzare 
l'aggiornamento puoi fare clic con il pulsante destro del mouse sull'origine e accedere a una 
re-acquisizione intelligente o a una nuova sincronizzazione.


3. Modifica degli spazi di lavoro

Peakto ha il supporto integrato per alcune app di editing di terze parti e consente di 
richiamare tali app in modo controllato attraverso l'uso di un'area di lavoro di modifica


Le aree di lavoro di modifica rappresentano un tipo specifico di interazione con un'app di 
modifica. Di solito consistono in :

-	 un rapido accesso a tutti i file modificati nell'applicazione

-	 una cartella di lavoro in cui è possibile aggiungere nuovi file

A seconda dell'app, il tipo di interazione o le funzionalità dell'area di lavoro sono diverse.


3.1.L'area di lavoro di editing Pixelmator Pro

Peakto include uno spazio di lavoro dedicato per Pixelmator Pro v3 e successivi.







- Questa area di lavoro ha le seguenti proprietà

- Tutti i file Pixelmator Pro vengono renderizzati al volo, in anteprima ad altissima 

risoluzione, utilizzando Pixelmator in background. Hai la stessa esperienza che in 
Pixelmator. Tu puoi fare clic sul file da Peakto per aprirlo in Pixelmator per la modifica 
dove è possibile accedere a tutti i livelli e le modifiche.


- Tutti i file Pixelmator Pro sono renderizzati al volo, fornendo anteprime ad altissima 
risoluzione utilizzando Pixelmator in background. Questo ti assicura di avere la stessa 
esperienza immersiva di Pixelmator stesso. Se desideri modificare un file, fai 
semplicemente clic su di esso all'interno di Peakto e si aprirà in Pixelmator, garantendoti 
l'accesso a tutti i tuoi livelli e modifiche.


- La sezione "Ultime modifiche" mostra l'ultimo documento che hai modificato in 
Pixelmator permettendoti di tornare facilmente e rapidamente a modificarli.


- Quando si aggiunge un nuovo file alla cartella di lavoro di quell'area di lavoro, viene 
creato un nuovo documento Pixelmator Pro dall'immagine di origine.


3.1.1. Modifica di qualsiasi immagine in Pixelmator Pro

Da Peakto, hai la possibilità di selezionare immagini da vari cataloghi come Capture One, 
Lightroom e altro ancora. Basta trascinarli e rilasciarli nella cartella di lavoro Pixelmator Pro 
situata nella barra laterale sinistra. Questa azione creerà un documento Pixelmator Pro 
utilizzando tali file. Facendo clic sui documenti verranno aperti in Pixelmator Pro, garantendo 
l'accesso a tutti i livelli e le modifiche. Se il tuo documento originale era un file RAW, 
apparirà nel livello RAW all'interno del documento Pixelmator Pro.


Una volta completate le modifiche, Peakto rifletterà l'immagine sincronizzata, catturando le 
modifiche apportate. Inoltre, Peakto indicherà che la tua immagine ora ha versioni diverse: il 
documento originale in Capture One e quello nuovo in Pixelmator Pro. Peakto può servire 
come punto di partenza per modificare la tua immagine in Pixelmator tenendo traccia di tutte 
le modifiche apportate.


Inoltre, hai la possibilità di creare un nuovo documento direttamente in Pixelmator. 
Trascinando e rilasciando un'immagine da Peakto a Pixelmator Pro, puoi aggiungerla al tuo 
nuovo documento. È quindi possibile salvare questo nuovo documento direttamente nella 
cartella di lavoro Peakto, dove apparirà in Peakto. Inoltre, puoi annotare le tue nuove 
immagini in Peakto e accedere all'analisi AI condotta all'interno di Peakto, inclusi punteggi 
estetici, analisi dei contenuti e armonie di colore.


3.2.L'area di lavoro di modifica DXO PhotoLab

Peakto include uno spazio di lavoro dedicato per DXO PhotoLab v5 e v6. Le modifiche di 
PhotoLab sono memorizzate in file sidecar dedicati chiamati file "dop" e questi file vengono 
ora rilevati da Peakto durante la scansione delle cartelle. Le modifiche in tali file o nuovi file 
vengono interpretate come eventi nelle immagini master sottostanti. Di conseguenza, 
Peakto ora creerà una versione dedicata per ciascuno di questi sidecar e recupererà 
l'anteprima generata da DXO per riflettere accuratamente l'aspetto dell'anteprima. Peakto 
eseguirà anche il rendering accurato delle copie virtuali create all'interno di DXO.




L'area di lavoro DXO PhotoLab viene fornita con 2 nuove voci di menu quando si 
seleziona un'immagine in Peakto che consentono di richiamare PhotoLab direttamente 
da Peakto:

-	 Modifica in DXO PhotoLab: avvierà PhotoLab sull'immagine master nella sua 
posizione

originale

-	 Modifica in una copia nella cartella di lavoro DXO PhotoLab : avvierà PhotoLab su 
una copia

del file master all'interno della cartella di lavoro.





Considera il seguente esempio:

-	 Iniziamo da un'immagine master in una cartella guardata. Peakto lo rende 
normalmente




- come un file. 
 

- Lanciare Modifica in DXO ed eseguire alcune modifiche in DXO. La versione 
renderizzata all'interno di Peakto è ora l'anteprima DXO per quel file.



 

- Aggiungi una copia virtuale in DXO per la stessa immagine:


Questa area di lavoro ha le seguenti proprietà:

-	 Il nodo All Version fa riferimento a tutti i file dop DXO e alle versioni associate,

completamente renderizzati

-	 Il nodo Last Edits fa riferimento alle stesse immagini del nodo All Versions ordinato 
per

data di modifica (le ultime modifiche sono in cima).

-	 Il nodo Working folder contiene le versioni DXO create all'interno della cartella di 
lavoro.


3.2.1. Fare riferimento alle versioni DXO al di fuori delle cartelle 
osservate


Peakto consente anche di fare riferimento alle versioni DXO archiviate al di fuori delle 
cartelle monitorate. Questo è interessante se le tue immagini sono referenziate in cataloghi 
come C1 o Lightroom. La modifica in DXO creerà un file dop all'interno della gerarchia di file 
originale che non viene scansionato da Peakto. Di conseguenza, quelle modifiche sarebbero 
mancanti. L'area di lavoro DXO PhotoLab è dotata di un'opzione che consente di 
aggiungere gerarchie di cartelle complete da scansionare solo per la presenza di file dop..


Per aggiungere questa gerarchia di cartelle:

-	 scegliere Edit Software Integration dal menu contestuale fdella sorgente




-	 Fare clic sul pulsante + per aggiungere una cartella all'elenco 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